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2. GETTING STARTED 

2.1. NEW IN SPARK 2™  

There are many improvements in Spark 2™ from the previous generation. The following are the main 

improvements: 

HARDWARE 

 Reduced footprint of 2.07” x 0.85” with the TruDrive attached, only 1.75” x 0.85” with it detached! 

 Integrated MaxAmp™ for loud and crisp audio. 

 Same realistic motion engine as Igniter 2™ to capture all the swings and clashes, no external clash sensor 

needed. 

FIRWMARE 

R3 

 3 Channel mixing for full RGB, allowing a distinct blade colors, blast, and clash/lockup effects per font. 

 Ability to engage the blade during Saber Tracks. 

 Linear hums and actions ported – choose to have audio files play in a row per font. 

 Improved LED driver and cleaner audio. 

 Alternating clash ported from I2-R2 for awesome clash effect. 

 WS2812 (NeoPixel) support. 

ORIGINAL 

 Support for 3 full fonts. 

 Saber Tracks audio player. 

 DualMix™ allows the main blade to be any mix of the two supported channels. 

 S2-R2 - One button support allows an install with a single momentary button. 

 S2-R2 – CrossSaber allows two side quillons or cross-guard blades to have a delayed ignition. 

2.2. IMPORTANT NOTES 

PLEASE READ THIS SUBSECTION CAREFULLY AS FAILURE TO DO SO COULD CAUSE DAMAGE TO THE SPARK™ 

BOARD. 

2.1.1. 3.7v Power Supply 

Spark 2™ is designed around a 3.7v power supply input. In general, the best way to run an Spark 2™ is to hook up a 

single 3.7v battery to the VBATT+ and VBATT-/GND pads. 

NEVER HOOK A 7.4V BATTERY DIRECTLY TO A SPARK 2™  UNDER ANY CIRCUMSTANCES, OR YOU WILL 

DESTROY THE BOARD. 
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NEVER REVERSE THE POLARITY OF VBATT+ AND VBATT-/GND. IF USING A CONNECTOR FOR THE 

BATTERY, MAKE SURE TO USE ONE THAT ONLY CLIPS IN ONE WAY TO PREVENT DAMAGING THE 

BOARD BY HOOKING THE POWER IN REVERSE. 

2.1.2. BATTERY PROTECTION 

Only use li-ion batteries that have a built-in protection circuit. NEVER USE UNPROTECTED CELLS AS THIS CAN 

CAUSE DAMAGE TO THE BATTERY AND/OR SPARK 2™. IMR batteries are okay but since they are not 

protected they can allow large amounts of power to the board and do not act like a fuse when there is a wiring 

issue, so for beginners it is recommended to use the standard Li-ion with the protection circuit. 

2.1.3. BATTERY BRANDS 

Because only one battery is being used, it is very important that a quality battery is selected to get the best 

experience from Spark 2™. From internal testing, the following brands are the only ones recommended for use 

with Igniter 2™: 

 AW 

 KeepPower 

 Solo’s Hold custom 

 Panasonic 

 Sayno 

 Tenergy 

These batteries have the best life and have the most consistent voltage output, allowing for the best experience 

through the entire life of the battery. If you choose to use another battery your experience will not be guaranteed. 

Specifically when using the Z6 LED, the only battery that Naigon’s Electronic Creations recommends is the AW 

3400mAh 18650 here: http://www.lighthound.com/AW-18650-Protected-3400-mAh-Rechargeable-Lithium-

Battery-_p_4149.html, or the AW 2900 mAh 18650 sold from lighthound here: http://www.lighthound.com/AW-

18650-Protected-2900-mAh-Rechargeable-Lithium-Battery_p_3671.html. These batteries will not trip when using 

all 6 die of the Z6 with Igniter 2™. 

Another good choice is the KeepPower with the 3 module protection circuit, as that battery can withstand high 

drain. These are usually on Ebay; just search for “KeepPower 18650 3400mAh” and pick ones that have the good 

protection circuit. 

Finally, Solo’s Hold just released a new Panasonic battery that has the 3 module protection circuit mentioned 

above. These are great as well and are highly recommended: http://www.soloshold.com. 

2.1.4. BATTERY SIZE 

The best battery to use is an 18650, space allowing. If that cannot be used, then an 18500, 17650, 16650, or 17500 

should be used, in that order. 14xxx batteries and 18350 batteries are not recommended due to their shorter life, 

and because those batteries may not be able to output enough power to run 4 die of a High Brightness LED 

(HBLED).LED Choices 

http://www.lighthound.com/AW-18650-Protected-3400-mAh-Rechargeable-Lithium-Battery-_p_4149.html
http://www.lighthound.com/AW-18650-Protected-3400-mAh-Rechargeable-Lithium-Battery-_p_4149.html
http://www.lighthound.com/AW-18650-Protected-2900-mAh-Rechargeable-Lithium-Battery_p_3671.html
http://www.lighthound.com/AW-18650-Protected-2900-mAh-Rechargeable-Lithium-Battery_p_3671.html
http://www.soloshold.com/
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Because Spark 2™ uses a 3.7v power source the LEDEngin LEDs will not work well. This is because LEDEngin’s green 

and blue dies require a forward voltage of 4.0v for maximum brightness. This it is highly recommended to use the 

TriCree LEDs, the Z6™ LED, The X2 or X4 LED, or the Qual Rebel LEDs. 

2.3. SPARK 2 LAYOUT 

Before getting started, it is important to familiarize yourself with the layout of Spark 2™, TruDrive™ and all of the 

pads on the board. This will help in wiring up the board for use in a saber. 

The following two diagrams show the important components of Igniter 2™, with an accompanying table describing 

what each component does. 

 

 

Figure 1 – Important components on the back of Spark 2™. 

Name Label Description 

1. Micro SD card 
holder 

NA Holds the micro SD card that contains the fonts and 
configuration for Spark™. Mark sure that the card is fully 
inserted before applying power to Spark™. 

2. TruDrive™ 
board 

LED DRIVER PCB Driving board that can power two high-power LEDs from 
Spark™. On Spark™ only the first two Pads are available. 

3. Battery +/- 
pads 

BAT+, BAT- Hook power and ground from a 3.7v Li-ion pack here. 

4. Speaker pads SPKR Hook a 1.5-2.0w, 8ohm speaker here. 

5. Accent 
Common + 

VLED+ Used to power all three of the accent LEDs. Optionally, 
additional static LEDs can be powered from this pad. The 
output is 3.3v, and it is rated at 200mA. 
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6. Accent LED 
pads 

1,2,3 Each pad can hold one 20mA accent LED. These LEDs will be 
sequenced by the chosen pattern. 

7. LED connect 
pads 

1,2,3,4 Pads that hook the TruDrive™ board to the Spark™ main 
board. Hook the corresponding numbers together with a wire. 
#4 is not used. 

8. Color Pads C1-, C2-, C3- Hook the main LED and flash LED cathodes to these pads. C4- 
is unused. 

9. Switch Pads MAIN, AUX Pads for the switches. MAIN can be a momentary or latching, 
aux must be a momentary. Make sure to select the correct 
type of switch for MAIN in the Config Editor. 

Figure 2 – Description of each component. 

2.4. TRUDRIVE™ SEPARATION  

Spark 2™ will come by default with the TruDrive™ attached to the main board. If it is desired to have the TruDrive™ 

separate from the main board for the install, then you can detach the two boards. 

To separate them, place a mouse pad at the edge of a table, and place Spark™ on the pad with the seam where 

TruDrive™ meets Spark right at the edge of the table, so that the entire TruDrive™ is off the table and the entire 

Spark™ is on the mouse pad. Then with one palm press and hold Spark™ to the pad, and gently use your other 

hand to press the other board until it starts to snap. Then simply wiggle the TruDrive™ back and forth until it 

comes free. 

It is important to note that once the board has been removed it cannot go back on; plan accordingly before 

separating the boards. 

3. WIRING DIAGRAMS 

The following diagrams are the most common to get your board up and running. 

Note: It is very important that the correct resistor be used between the negative pad of the LED and C1-, C2-, C3- 

and C4- to prevent burning out the LED for warm color LEDs. For Rebel LEDs if a red, red-orange or amber LED is 

used, then a 1ohm 1watt resister is needed. For any other Rebel colors a resistor is not needed. The STTH2L06 

diode can be used in place of the resistor and it is a slightly smaller part. 

2.5. BASIC WIRING 

This is the most basic wiring that is possible to get the board up and running. It is great for testing your Spark 2™ 

on the bench, or if you are doing a simple install into a saber that will have a removable battery. 
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Figure 3 – Basic wiring for Spark 2™. This will drive a single main LED and would require a removable battery for charging. Note that a 

resistor between the blue wire and C1- of TruDrive™ would be needed if the LED is red, amber, or red-orange. 

2.6. FLASH WIRING 

Wiring a basic setup to have a TriCree LED with two die of one color and a third die for a flash color is a popular 

choice for Spark 2™. This wiring diagram shows how to utilize that setup. 

The preferred LED to use for this setup is the TriCree, as it has an optic made specifically for this configuration, and 

it has a great balance of brightness with good efficiency, so it doesn’t waste too much power. It also produces a 

very even blade when diffused and sanded. The X2/X4 previously recommended is no longer preferred as it’s optic 

doesn’t allow enough of the brightness down the tube evenly. 
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Figure 4 – Wiring a Spark2™ for a main blade and a flash color. Note that the colors can be mixed, so it is possible to have a mix of the two, 

or utilize the flash color as the main blade color for one of the three fonts. 

For this setup with the bridging shown in <>, it is recommended to set c1Color and c2Color, c1Clsh and c2Clsh, and 

c1Blst and c2Blast to the same values for a given font to ensure that both LEDs of that same color are enabled. 

2.7. RGB WIRING 

NEW IN R3! Spark 2™ now supports full RGB color mixing! This diagram shows how to hook up an R/G/rB die for 

the ultimate color mixing. The recommended LED to use by far is Naigon’s Electronic Creations own NECree RGB 

v2. It utilizes the highest binned XP-E2 Cree dies, in a common-positive wiring with the STTH2L06 diode already 

installed, so NO EXTERNAL RESISTORS ARE REQUIRED for the LED. 
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Figure 5 – RGrB wiring utilizing the NECree RGB v2 LED. Note that no external resistors are needed with this LED. 

2.8. COLOR MATCHING CRYSTAL MATCHING 

With the advent of color mixing many people are wanting a blade matching crystal chamber to go along with their 

build. If you want to experience this thrill, then look no further! The following diagram shows how to get this LED 

wired and working. 
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Figure 6 - Wiring with an RGB crystal chamber. This will have an RGB led that matches the blade color and pulses with the blade. Note that 

all three pins of the REB LED have a resistor since power is coming from the battery. I recommend a 22-33ohm for R1, and a 1ohm each for 

R2. 

2.9. CROSS-SABER WIRING 

For those that want to mimic the saber with two side quillion or cross-guard blades that have the delayed 

extension, the following wiring diagram is provided. This supports a saber where all three blades are the same 

color, with a secondary flash color for either the main blade or all blades. The diagram for the former is shown 

here. The master setting “Cross-Saber” must be enabled for this to work correctly. 

I’ve provided the wiring for a TriCree though any other LED would be similar. If using a TriCree I recommend only 

hooking up two of the three die for the side LEDs to prevent battery drain and to ensure that a single channel does 

not get too hot. 

Note that when using Red or Amber die resistors would be needed between the die and the appropriate Cn- pad. 
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Figure 7 – Wiring for the Cross-Saber feature. This is for a single color blade and side guards. Note that 4 resistors or STTH2L06 diodes would 

be needed for a Red/amber color, labeled as R1-R4 in the diagram. This wiring also utilizes a single AV switch, so the configuration would 

need to reflect that (one button or one button with motion). Finally, c1Color and c2Color could be set independently if the die off C2- was a 

different color to allow for the flash-clash effects. 

After wiring this, make sure that not only Cross-Saber is enabled in the master section, but each font where it is 

desired for the side LEDs to be on will also need C3PERCENT set to 95 in the master, and then C3COLOR set to a 

non-zero value for each effect where the secondary blade(s) should be on. If you want a simple static blade then 

just set all three c3 values C3COLOR, C3BLST, C3CLSH to 255. However, if you want them to only come on for flash 

effects, set C3COLOR to 0, but the rest to 255. You can also turn them down some to something like 155 to save 

some power. For C1COLOR and C2COLOR, they could be set the same if the TriCree is all red, or set independently 

to have c2Color off for the main blade and enabled for the other effects, allowing the main blade to have a flash-

clash color. 

2.10. WS2812 WIRING 

NEW IN R3. Spark 2™ now supports WS2812 strip blades! Wiring them has change a bit since the initial release, so 

pay attention to the diagram below. 
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Notice that a resistor that is somewhere between 270ohm to 400ohm is required. It doesn’t really matter what the 

value is, it’s just there to protect the data line. I usually use a 330ohm as it is a pretty common value. 

Also, this example is using the triangular prism style, where three strips are wired in parallel. To save power it is 

possible to just do two strips back to back, though I’ve found this increases the unsightly vertical shadowing. To do 

this wiring one strip can simply be omitted since these are just in parallel wiring. 

Finally, it is extremely important to use a 10amp battery with this type of blade as it does tend to draw a lot of 

amperage. 

 

Figure 8 – Wiring a triangular prism style WS2812 blade with 3 parallel strips. It is also possible to do two strips back to back, though that 

increases the vertical shadowing and doesn’t look as good when looking right at the seams. Notice the extra ground wire between the 

TruDrive and main board; this is recommended to ensure adequate amperage can flow to the string. 

 

2.11. FULL WIRING 

This diagram shows how to wire a recharge port along with accent LEDs and the NECree RGB v2 LED, allowing all 

the features of Spark 2™ to be utilized. The recharge port also acts as a kill key, where pushing a kill plug into the 

port will stop power from getting to the board.  
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Figure 9 – Full wiring using all accent LEDs and a recharge port/kill key combo. This wiring will allow all features of Spark 2™ to be 

experienced, including full RGrB color mixing. 

4. CONFIGURATION EDITING 

Once Spark 2™ has been wired according to the wiring above then it will work immediately with the default 

configuration. However, changing the fonts and effects is completely possible and encouraged by using the Spark™ 

Config Editor. The following section will go through installing and using the editor to modify Spark™ configuration. 

3.1. INSTALLATION 

To install the application, launch the .msi file from the installer zip file. You can get the file from SaberIgniter.com. 

A version is also included on the micro SD card that came with Igniter™, but I recommend going to the site to get 

the newest version in case any enhancements have been made to the program. Click through the wizard until the 

application launches. 

3.2. COPY FILES TO YOUR MACHINE 

Before opening Spark™ Config Editor you will need to copy the files you want to edit from the micro SD card to 

your local computer. First, insert your micro SD card into your computer using your SD card reader. If you do not 

currently have one, I recommend this cheap one off eBay: Micro SD card. 

Then, open a new window and find a place to put a new Spark directory. In this example the Spark directory will be 

placed right on the root c:\ drive. Create a new directory and name it “Spark”. Then, inside that directory, create 

another folder with the name of your saber. In this example, “Saber1” will be used. 

http://www.ebay.com/itm/New-USB-2-0-SD-Micro-SD-TF-T-Flash-Memory-Card-Reader-/160575697242?pt=US_Memory_Card_Readers_Adapters&hash=item25630eb15a
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Now, with both the Saber1 empty directory open and the micro SD card opened, select all the files from the micro 

SD card, and drag them into the Saber1 directory. When done, all the files should be copied to your hard-drive as 

shown below. 

 

Figure 10 – After creating a new directory called “c:\Spark\Saber1”, the files are copied from the micro SD card (on the right) to the new 

Saber1 folder (on the left). From here edits can be made to the files from the config editor. 

 

3.3. LAUNCHING THE APPLICATION 

To launch the config editor, you can use either the desktop shortcut that was created, or you can use the shortcut 

from the Start Menu. Once launched you should see the program as below: 
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Figure 11 – Spark Config Editor launched after installation. 

You can then go to File->Open, and the open dialogue will appear. Navigate to the “c:\Spark\Saber1” folder and 

then go into one of the fonts to edit. When you see the config.ini appear in the window, double click it or select it 

and click open to load the program for editing this font. 
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Figure 12 – Navigate to “c:\Spark\Saber1” in the window, and then select either font1, font2 or font3 to edit. When you see config.ini, 

double click it to open editing for the font. 

3.4. CHANGING SOUNDFONTS 

If a new font is going to be used in place of one that is currently on the card, it is important to copy that font 

BEFORE THE SPARK™ CONFIG EDITOR IS LOADED. This is because the program will scan the sound font and make 

sure all variables regarding the number of font files is correct. FAILURE TO DO THIS CAN RESULT IN THE SABER 

LOCKING UP WHEN USING THE FONT. 

To copy a new sound font, first go to the font that you want to change. In this example it will be 

“c:\Spark\Saber1\font1”.  Navigate to that directory in explorer and then select all the .wav files. I find the easiest 

way to do that is to select all, then hold control and click the config.ini and accent.ini files (along with the backup 

folder if already present) to unselect those files. Then you can delete the original files to the recycle bin. Make sure 

you have a separate backup of these waves before doing this. 
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Figure 13 – Delete the existing font by selecting all the files, then hold control and uncheck ‘accent.ini’, ‘config.ini’, and ‘backup’ if it is 

present. Then the selected wav files can be deleted or cut and pasted into a backup location. 

After the wav files are removed and all that is left is the config files and backup folder, you can copy in all the new 

wav files from a new font. You can find these from online saber sound websites, and there are some free ones 

available from my website as well: http://SaberIgniter.com/fonts.aspx. 

3.5. EDITING SETTINGS 

With the file open, you have access to all the configuration settings from spark. Unlike Igniter™ which has a bunch 

of sliders for individual parameters, Spark 2™ has simple dropdown values that represent high-level pre-configured 

features. This makes editing a breeze and removes any confusion with what certain settings control. 

The following sections go over each tab of the config editor, and give a description on how the settings are used. 

3.5.1. MASTER 

The master tab in the config editor contains global settings that generally apply to every font, not just the current 

loaded font. The following settings are utilized in the master tab for Spark 2™: 

http://saberigniter.com/fonts.aspx
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Figure 14 – Screen shot of the master tab. 

C1PERCENT, C2PERCENT, C3PERCENT – drive settings that control the percentage of the LED. Use these to turn 

down the overall brightness of a die regardless of what color value is set. For example, setting C3PERCENT to 185 

with cross guard will always turn down the side blades even if their color is set to 255, allowing some power saving 

for those short blades. 

CROSSGUARD – Enable the cross-guard functionality, delaying the extension of the LEDs connected to C3-. 

REVERSE RED/GREEN (REVERSERG) – Applicable only when using a WS2812 (NeoPixel) blade. This value indicates 

that the 5mm Straw Hat style blade is being used, and that the red and green values will be reversed. This allows 

the standard convention of c1 = blue, c2 = green, c3 = red to be used. 

BUTTON LAYOUT (BTYPE) – Indicates the type of button solution utilized. Choices are “Two Buttons”, “One 

Button”, and “One Button w/ motion”. The latter allows all features of the board to be used with only a single 

momentary switch. 

MBUTTON – Sets the type of button for the main switch, either momentary or latching. Not applicapable if the 

button type is set to “One Button” or “One Button w/ Motion” as either of those require a momentary switch.  
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SWAP BUTTONS (BSWAP) – Set this to swap the location of the main and aux buttons. Only recommended if both 

are momentary. 

USE BOOT SOUND (BOOT) – Indicates if when the saber starts it should play the boot sound, or the font.wav from 

the first font. 

LOWPWR – Time in seconds that the saber is in idle before it goes into low power mode, cutting the accent LEDs 

and the motion. A single aux press (or main button tap for a single button) will wake the board. Set to zero (0) to 

never enter low power. 

NSTRP – Applicable only when using a WS2812 (NeoPixel) blade. This defines the length of a single strip of the 

blade – for example, when using a triangular prism blade, if the lengths of each strip are 144, 145, and 144, then 

choose 145 or the side with the maximum length. Currently the maximum number supported is 255. 

After making all the edits desired, to go File->Save in the program to save the new configuration settings. Repeat 

for any other fonts where the effects are going to be configured before transferring the files back to the micro SD 

card. 

3.5.2. BLADE EFFECTS 

The blade effects tab controls the blade effects settings, which define the pulse and clash style and lengths, along 

with extension and retraction. Each setting is listed below with a description of how to use the parameter. 
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Figure 15 – Screenshot of the Blade Effects tab. 

BLDEEFFECT – Defines the pulsing effect for the blade, choosing either a pulsing or flickering style. Use the 

simulator to get an idea of how the effect will look in the saber. 

CLSHEFFECT – Defines the clash effect for the blade. Use the simulator to get an idea of how the effect will look in 

the saber. 

USE ALTERNATING CLASH (ACLSH) – NEW IN R3. When enabled, the clash will vary between the clash color and 

blade color for a more dramatic effect. 

INLEN – Length in milliseconds for the retraction effect. Choose zero (0) to have the effect match the length of the 

file. 

OUTLEN – Length in milliseconds for the extension effect. Choose zero (0) to have the effect match the length of 

the file. 

NIMPTBLAST – NEW IN R3. Applicable only when using a WS2812 (NeoPixel) blade. This setting defines the size 

for the Impact Blast™ feature. This value should be between 0 and half the length of the blade, as it defines where 

the impact range should occur from the middle. Setting to zero (0) will disable the feature. 
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3.5.3. BLADE COLOR 

This is one of the most important tabs, the one that controls the blade color for the current font. It allows 

independent control for the blade, blast, and clash/lockup color. 

It’s important to note how color editing works. First, in all my examples I assume BGR – that is the (royal) blue die 

is hooked to C1, the green die is hooked to C2, and the red die is hooked to C3. Following this, setting C1COLOR to 

255, C2COLOR to zero (0), and C3COLOR to zero (0) would be blue. Similarly, setting C1COLOR to zero (0), 

C2COLOR to 255, and C3COLOR to zero (0) would be green. 

To dial in a specific color with RGB, I recommend going to the online selector here: 

https://galactic.ink/sphere/ 

It helps choose colors and then gives the r,g,b representation of those colors. You can use the bottom 3 sliders to 

help select a color to input. Remember that you need to reverse the order as they use r,g,b not b,g,r.  

 

Figure 16 – The color settings tab. This tab contains the blade color, the blast color, and the clash/lockup color. 

https://galactic.ink/sphere/
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If you are using a TriCree with 2 or more die the same color, just always treat those two as the same value. For 

example, for a B,B,G die, you can set c1Color = 255 and c2Color = 255 to get the blue at full brightness. If you want 

a cyan color you might do C1COLOR = 80, C2COLOR = 80, and C3COLOR = 255. 

You can also use the simulator to see the color that is selected. Note that by default the program assumes BGR; 

this can be changed in the Options->Color Settings menu. Note that changing this will have NO effect on the actual 

colors that actually show up on the saber; rather, you set this to match the saber install. This is why I HIGHLY 

recommend installing BGR so that all the examples and colors line up to the defaults. 

3.5.4. AUDIO TAB 

The audio tab contains some settings directly related to the audio. These settings are described in detail below. 

 

Figure 17 – Screenshot of the Audio tab. 

LINEAR HUM/IN/OUT – NEW IN R3. Enable this setting to have the hum, extension, and retraction sounds play in 

order as they appear on disk instead of being random order. 

LINEAR ACTION – NEW IN R3. Enable this setting to have the swing, slash, clash, blast, and lockup sounds play in 

order instead of being randomly selected. 
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HUMSTART – Length in milliseconds in which the hum starts playing before the end of the extension sound. For 

example, if the extension sound is 1,000ms (1 second), and this is set to 400ms, then the extension will play 600ms 

before the hum starts. 

VOLHUM – Volume for the hum sounds. Values go from 0 to 16, 0 being completely off and 16 being full volume. 

VOLEFF – Volume for the effect sounds. Values go from 0 to 16, 0 being completely off and 16 being full volume. 

3.5.5. MOTION TAB 

This section contains the motion sensitivity settings. Each setting is described below. 

 

Figure 18 – Screenshot of the Motion tab. 

SWNGTHRESH – Swing threshold to determine the swing sensitivity. Zero (0) means very sensitive, 255 means it 

takes some movement before a swing will register. 

SLSHTHRESH – Slash threshold to determine the sensitivity of when a slash is registered. A slash is a fast/hard 

swing. Note that this setting takes effect after SWNGTHRESH, meaning it is impossible to set the values in such a 

way that it is impossible to register one or the other. 
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CLSHTHRESH – Clash threshold to determine the sensitivity of when a clash is registered. Zero (0) means hardly 

any impact will trigger it, 255 means a very hard whack is required. 

GYROXTHRESH – Only applicable when using a single button. This determines how hard of a twist is required 

before the motion is recognized by the system. Zero (0) means not much twist will be required; 255 means it 

requires a very hard force. 

GYROYZTHRESH – Only applicable when using a single button. This determines how much play in the other 

directions is allowed when registering a twist. The higher the value the more play is allowed, making the effect 

easier to perform. Note that this is the opposite as the other threshold values in which higher values make the 

effect more difficult to trigger. 

3.5.6. ADVANCED TAB 

The advanced settings currently contain the adjustments for getting RGB correct. These should only be adjusted if 

you are noticing color separation during extension and retraction effects, or during deep pulse effects. For 

example, if on a purple color it comes out red first and then fades to a purple at the end of the extension, adjust 

the C3AD value down, and/or the C1AD and C2AD values up, assuming that you have the B,G,R wiring convention. 

3.5.7. ACCENT TAB 

Accent settings tab. Unlike Igniter™ which has complicated accent settings, Spark 2™ has simple drop-downs to run 

the accents. This allows for easy setup and ensures a nice pattern. 

To change the accent pattern for each mode, simply choose the pattern from the drop down for that mode. To see 

the pattern in the simulator, make sure that the desired mode is chosen from the Accent mode dropdown. 
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Figure 19 – Screenshot of the Accent tab. Use the individual dropdowns to set each effect. The top dropdown is used to indicate to the 

simulator which one should be running in the simulator for inspection. 

 

3.6. GENERATE DUAL OUT SOUNDS FOR CROSS-SABER 

The best experience for Cross-Saber is to utilize the new dual out sounds, named DOUTNN.WAV, where NN is a 

number 01 to 99. Basically, these files would be a second extension mixed in the original at the delay of humStart 

in the config, which would make a second delayed sound when the second blades turn on. Creating these manually 

would be a tedious task. However, with the new Create Dual Out Wavs function in the config editor, it is a breeze. 

For each font you just open the font, go to Edit->Create Dual Out Wavs, and click. That’s it; one dual out wav will 

be created for each out wav for the font, with the secondary extension mixed at the delay of humStart set in the 

config. 

Once created, just save the font so the number is updated any the font will now use the dual out sounds if Cross-

Saber is enabled. Note that if there are no dual out sounds the normal out ones will be used so this is not a 

mandatory step, but does enhance the overall experience. 
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3.7. FORMAT MICRO SD 

I no longer recommend using Windows built-in format tool to format the SD cards, as it doesn’t do a true UNIX 

style format. Instead, it is much better to use a good 3rd party tool, such as SDFormatter. 

https://www.sdcard.org/downloads/formatter_4/ 

This tool will properly format the SD card for use with all my boards. 

Upon launching the tool the window below will be shown 

 

Figure 20 – Using SD Formatter to format the micro SD card for use with any of my products, including Spark 2™, Spark Color 2™, Igniter 2™, 

and Sound Hornet™. 

To format an SD card, simply select the drive of the micro SD card from the Select card dropdown, type a name 

into the Volume label field, ensure Quick Format is chosen, and hit format, clicking yes on the prompt that 

appears. This will format the card and erase the existing contents, ensuring it is ready for use with your board. 

Note that I do this for every card that gets sent with the board, but this is necessary for those that are changing 

fonts and/or have a new SD card. 

3.8. COPY FILES BACK TO THE MICRO SD 

https://www.sdcard.org/downloads/formatter_4/
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To copy the files back, simply move all the files from the “c:\Spark\Saber1” directory to the root of the micro SD 

car. This will ensure that the files are written well and can be accessed quickly by Spark 2™. Once this step is done 

the micro SD card is ready to be loaded back on to Spark 2™ to enjoy the new settings and fonts! 

5. SABER OPERATION 

To use your saber, with the micro SD card inserted and the wiring correctly completed, insert the battery or pull 

the kill key. You should hear the boot sound or first font sound play (depending on the config setting), and you 

should also see the first accent LED blinking rapidly. After this your saber will load into idle mode for the first font. 

There are three main modes of operation for the saber: Idle mode, Running mode and Tracks mode. These two 

modes will be discussed in detail in the next sections. 

4.1. IDLE MODE 

Idle mode is when the saber is loaded for a font but not running. This is where the accent LEDs are running the idle 

pattern, and the saber is ready for use. In this mode there are two ways to interact with the saber. The first is 

hitting the aux button to advance to the next font. When you are on font three, hitting aux goes back to font1. 

Spark™ always assumes that there are 3 fonts present on the config card, so make sure they are always present on 

the micro SD card. 

The other way to interact with the saber is by hitting the main button. This puts the saber in running mode. For 

more details on that see the next section. 

6.1.1. IDLE MODE INTERACTION TABLE 

The following table lists all the interactivity that is possible with the saber while in idle mode. 

Entry Label Action Description 

Main button MAIN+/- Press/Latch Pressing the main button (latching when it is a latching switch) 
puts the saber into running mode for font1 and font2; for 
font3 it engages Saber Tracks. 

Aux button AUX+/- Press Advances to the next font. 

Twist Hilt NA NA When One Button is set with motion in the master, twisting 
the hilt while in idle mode will advance to the next font. 

4.2. RUNNING MODE 

When the saber is running, there are many actions that are possible. Swings, Blaster Blocks, Clashes, Lockups and 

retraction all become available. Further, this is when the main LED runs and accent LEDs follow the patterns for the 

actions performed. A detailed description on how to interact with the saber is given in the following subsection. 

To stop the saber from running, simply hold down the main button (unlatch if it is a latching switch) until the 

retraction sound and effect happen. The saber will then return to Idle mode. From here you can re-insert the kill 

key or remove the battery. Do not remove power when the saber is running, as this can cause the micro SD card to 

get an incorrect formatting, and then it would need to be reformatted. Granted this is very rare but it is better to 

put the saber into Idle before disconnecting the power. 
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6.2.1. RUNNING MODE INTERACTION TABLE 

The following table lists all the interactivity that is possible with the saber while in running mode. If the One Button 

is enabled in the config, please see the interaction guide for one button: 6.2.2 RUNNING INTERACTION FOR ONE 

BUTTON. 

Entry Label Action Description 

Aux Button AUX +/- Press Pressing the aux button engages Blaster Block mode. Once in 
this mode, swinging the saber will perform EzBlaster™, where 
another Blaster Block will be performed. Keeping the saber 
still will cause the mode to exit. 

Aux Button AUX +/- Hold Holding the aux button engages the Lockup effect. Depending 
on the chosen config setting, either releasing the button or 
tapping it again will cause the mode to exit. 

Aux Button AUX +/- Press (in 
Clash) 

Pressing the AUX button will perform EzClash™; immediately 
after the press the Lockup sound will play when in Clash 
mode. 

Swing saber NA NA Swinging the saber causes a single swing sound to be played. 
If the swing is performed rapidly then a Slash sound will be 
performed. 

Hit saber/Blade CS NA Hitting the saber against something or hitting your hand on 
the hilt will cause the Clash sound to play. To return to 
running simply wait for the clash to finish. 

Main Button MAIN+/- Hold/Unlatch Holding or unlatching the main button will cause the 
retraction sound to play and then the saber will return to Idle 
mode. 

6.2.2. RUNNING INTERACTION FOR ONE BUTTON 

If the saber is configured to run with one button, the following is the interaction guide while operating the saber: 

Entry Label Action Description 

Main Button MAIN +/- Press Pressing the aux button engages Blaster Block mode. Once in 
this mode, swinging the saber will perform EzBlaster™, where 
another Blaster Block will be performed. Keeping the saber 
still will cause the mode to exit. 

Main Button AUX +/- Press (in 
Clash) 

Pressing the AUX button will perform EzClash™; immediately 
after the press the Lockup sound will play when in Clash 
mode. 

Swing saber NA NA Swinging the saber causes a single swing sound to be played. 
If the swing is performed rapidly then a Slash sound will be 
performed. 

Hit saber/Blade CS NA Hitting the saber against something or hitting your hand on 
the hilt will cause the Clash sound to play. To return to 
running simply wait for the clash to finish. 

Main Button MAIN+/- Hold Holding or unlatching the main button will cause the 
retraction sound to play and then the saber will return to Idle 
mode. 

6.2.3. DUAL MIX™ 
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DualMix™ is the newest feature for Spark 2™ In the previous version of Spark™, Blade Swap™ allowed the user to 

select one of the two die channels as the main blade. This worked well to have two separate blade colors, but still 

made colors like purple difficult as the blue and red die would need to be wired together, and could not be turned 

from the firmware. 

With DualMix™ now both the two die channels can be combined, allowing for mixed main blade colors. For 

example, for a rBrBRR X4, and C1 is running rBrB and C2 is running RR, the main blade could be all royal blue, all 

red, or some combination of the two, allowing not only a blue and red main blade, but also all the shades of purple 

and pink. Similar with an X4 that had GGRR, you would not only get a red or green blade choice, but also the choice 

of any of the orange-yellow possible mixes! 

Finally, now that Spark 2™ supports 3 full fonts, 3 separate mixes can be used for the main blade, allowing for both 

the two independent colors and a mixed color, or all 3 mixed colors for a wide possibility of blade colors! 

4.3. SABER TRACKS 

The menu in Spark 2™ now cycles through each of the 3 fonts, and then to the special Saber Tracks font, before 

cycling back to the first font. After hearing the “Saber Tracks” audio clip in the menu, you will immediately be 

entered into Saber Tracks™ mode and the first track will immediately start playing. In Spark 2™ all the 

TRACKNN.WAV files go in the /tracks folder right off the root of the micro SD card. 

New in R3 – Saber Tracks™ now has the ability to engage the blade while the music is playing! After hearing the 

music start, you can either press and hold the main button (if it is momentary) or latch the main button (if it is 

latching) to ignite the blade. The extension effect will occur followed by the pulsing of the blade. No additional 

effects will be displayed, and now sound effects will play, but the music will stream non-stop. 

The blade color and pulse for Saber Tracks™ in Spark 2™ will be selected from the last used font. This means that 

Saber Tracks can be used with any of the 3 blade colors for each of the 3 fonts. 

To turn off the blade, simply hold the main button (if it is momentary), or unlatch the main button (if it is latching). 

Holding the aux button or doing the twist motion for a single button install will exit Saber Tracks and load the first 

font. 

6.2.4. SABER TRACKS INTERACTIVITY 

The following table describes the interactivity for Saber Tracks. 

Entry Label Action Description 

Aux Button AUX +/- Press Advances to the next track. When the last track file is reached 
it goes back to the beginning. 

Main Button MAIN +/- Hold/Latch Holding or latching the main button will enable the blade, 
doing the extension effect first then the pulse effect. 

Main Button MAIN +/- Hold/Unlatch Holding or unlatching the main button will cause the blade to 
retract if the blade is current enabled. 

Aux Button AUX +/- Hold Holding the aux button will exit Saber Tracks™ and load the 
first font. 

When One Button is enabled in the master section, the following defines the interaction 
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Entry Label Action Description 

Main Button MAIN +/- Press Advances to the next track. When the last track file is reached 
it goes back to the beginning. 

Main Button MAIN +/- Hold Holding the main button enables the blade, doing the 
extension effect first then the pulse effect. 

Main Button MAIN +/- Hold Holding the main button when the blade is enabled will do the 
retraction and turn off the blade. 

Twist NA Rotate Rotating the saber for a single button install will exit Saber 
Tracks™ for a single button installation. 
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Revision History 

Date Revision 

16 February 2015 Initial version of Spark 2™ 

13 October 2017 Updated for S2-R3 

 


